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Preface
About This Manual
This manual outlines the steps to follow to get started with the Xilinx
software. It also covers installation and authorization of the Xilinx
software and online documentation.

Manual Contents
This manual covers the following topics.
●

Chapter 1, “Getting Started,” outlines the tasks to follow to get
started with the Xilinx software.

●

Chapter 2, “Installing PC Products,” covers installation and
authorization of Xilinx software on a personal computer.

●

Chapter 3, “Installing Workstation Products,” covers installation
and authorization of Xilinx software on a workstation.

●

Chapter 4, “Installing Xilinx Online Documentation,” describes
how to install a reader and a set of documents on a personal
computer and on a workstation. It also provides a descriptive list
of Xilinx manuals.

●

Chapter 5, “Disk Space Management,” describes how to minimize
disk space use.

●

Appendix A, “System Requirements for Xilinx Software,” lists the
system requirements for using the Setup program and the Xilinx
software.

Getting Started & Installation Guide — 0401320 01

i

Chapter.book : Preface

ii Mon Sep 25 13:20:08 1995

Getting Started & Installation Guide

ii

●

Appendix B, “Accessing Your CD-ROM,” describes how to set up
your PC to execute software, tutorials, and online documentation
directly from a CD-ROM and how to access a workstation
CD-ROM using PC-NFS.

●

Appendix C, “Setting Up the Xilinx Environment,” explains how
to manually update your configuration file.

●

Appendix D, “Using DOS Products,” explains how to copy Xilinx
DOS-based software on diskettes, install from diskettes, authorize
your products from DOS and execute the DOS-based XACTstep
products in an MS-DOS shell from Windows.

●

Appendix E, “Troubleshooting,” lists solutions to possible errors
you might encounter when running the installation program.
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Conventions
The following conventions are used in this manual’s syntactical
statements:
Courier font
regular

System messages or program files appear
in regular Courier font.

Courier font
bold

Literal commands that you must enter in
syntax statements are in bold Courier font.

italic font

Variables that you replace in syntax
statements are in italic font.

[ ]

Square brackets denote optional items or
parameters. However, in bus specifications,
such as bus [7:0], they are required.

{ }

Braces enclose a list of items from which
you must choose one or more.

·
·
·

A vertical ellipsis indicates material that has
been omitted.

...

A horizontal ellipsis indicates that the
preceding can be repeated one or more
times.

|

A vertical bar separates items in a list of
choices.

↵

This symbol denotes a carriage return.
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Chapter 1

Getting Started
This manual explains how to install Xilinx software products and
how to configure your system ready for use with the XACTstep
software.

Guidelines
The following is a summary of the steps to follow for getting ready to
use your software.
●

Fill out the enclosed registration card.
Fax or mail Xilinx the card to receive future updates and product
information.

●

Read the release documents.
●

●

●

Verify the contents of the box against the item list on page 1 of
the release notes.
Read about new features and important software issues.

Install your XACTstep software.
Follow the instructions for your platform in this guide to install
your software.
Before installing software, you must first check that your system
meets the requirements outlined in the “System Requirements for
Xilinx Software” appendix, then continue with the appropriate
chapter for your type of installation: “Installing PC Products” or
“Installing Workstation Products.”
You can install a complete software package or an individual
product. In either case you can choose to install the selected
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product in its entirety using the Quick Install option, or partially
using the Custom Install option.
If you have a Windows PC and you do not want to install the
software, you can execute it directly from the CD-ROM, as
explained in the “Using Your CD-ROM” appendix.
●

Install online documentation.
Starting with the XACTstep 5.2/6.0 release, you can access Xilinx
documentation online on a PC running Windows or on a Sun
workstation*. In addition, interactive tutorials and contextsensitive help are available for all Windows-based programs.
Context-sensitive help is available from the Help menu of each
program. It is also available from selection dialog boxes that
include a Help button. Refer to the manual for each of these
programs for more information.
To use online documentation, you must first install the Adobe
Acrobat reader. If you have a PC running Windows, install the
reader at the time you install the software from the Xilinx Setup
program. If you have a Sun 4 workstation, refer to the “Using
Xilinx Online Documentation” chapter, in this manual.

●

License your XACTstep software.
After installing your software, you must authorize it.
●

●

●

To authorize software on a PC, refer to the “Using Xilinx
Security” section in this manual.
To authorize your software on a workstation, refer to the
“License Management for Workstations” section in this
manual.

Address your questions and comments as follows.
United States and Canada:
Technical HOTLINE
Customer Service

(800) 255-7778
(800) 624-4782

In Europe, Japan, Asia, and other areas, contact your local
distributor.

*. Other platforms will be supported in later releases.

1-2

Xilinx Development System

Chapter.book : covch2

3 Mon Sep 25 13:20:08 1995

Getting Started
& Installation
Guide

Getting Started & Installation Guide — 0401320 01

Installing PC Products

Printed in U.S.A.

Chapter.book : covch2

4 Mon Sep 25 13:20:08 1995

Getting Started & Installation Guide

Xilinx Development System

Chapter.book : Chapter.2

1 Mon Sep 25 13:20:08 1995

Chapter 2

Installing PC Products
This chapter explains how to install Xilinx Windows and DOS
programs on a personal computer. The installation includes installing
WIN32S, starting the Setup program to load the Xilinx software to
your PC, and authorizing the software.
Note: To execute a DOS program from a DOS shell in Windows, refer
to the “Using DOS Programs” appendix.

Installation Procedure
Installing Xilinx programs in the Windows environment is a two-step
process. You must first install WIN32S before you can start the Setup
program.

Installing WIN32S
Xilinx programs require the installation of WIN32S Version 1.25.42.0.
If you do not have WIN32S installed on your system or are not sure if
it is installed, follow this procedure:
1. If Windows is not already running, invoke it by typing win↵.
2. Insert the CD-ROM into a drive and determine the source drive
letter. This installation guide assumes d: is the CD-ROM drive. If
it is different on your system, substitute accordingly for the
following instructions.
3. From the Program Manager, select File ➝ Run and enter
d:\win32s\disk1\setup.exe↵.
4. Follow the instructions on your screen.
Note: You should also install the Freecell program from the Setup
program to test the WIN32S installation. Then, test the Freecell
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program by clicking on the Freecell icon in the Win32 Applications
group. If Freecell does not execute, you must re-install WIN32S.
However, before re-installing WIN32S you must first de-install it as
explained in the “De-installing WIN32S” section.
5. Continue with the instructions in the section, “Starting the Xilinx
Setup Program.”

De-installing WIN32S
This section explains how to remove WIN32S from your installation.
You should remove this program any time you need to re-install it.
1. Delete the following files from the \windows\system directory:
win32s16.dll
w32sys.dll
winmm16.dll
win32s.ini
2. In addition, delete all the files that are included in the
\windows\system\win32s directory.
3. Edit the [boot description] section in your \windows\system.ini
file by removing the winmm16.dll entry of the driver list, as
follows:
For example, change
drivers=mmsystem.dll msmixmgr.dll winmm16.dll
to
drivers=mmsystem.dll msmixmgr.dll
4. Delete the following line under the [386Enh] section:
device=c:\windows\system\win32s\w32s.386

Starting the Xilinx Setup Program
Follow these steps to install the Xilinx software.
Note: To access the CD-ROM drive located on a Sun workstation or
to run Xilinx PC software directly from your CD-ROM without
installing on your hard disk drive, see the “Accessing Your
CD-ROM” appendix for instructions. However, to access the tutorials
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or the online documentation from the CD-ROM, you must still use
the Xilinx Setup program to select these options. The installation
program will install required software, set up your path, and create
program icons.
1. Check the system requirements defined in the “System
Requirements for Xilinx Software” appendix.
2. If Windows is not already running, invoke it by typing win↵.
3. Insert the CD-ROM into a drive and determine the source drive
letter. This installation guide assumes d: is the CD-ROM drive. If
it is different on your system, substitute accordingly for the
following instructions.
4. From the Program Manager, select File ➝ Run and enter
d:\setup.exe↵.
5. Follow the instructions on your screen.
By default, Setup copies the XACTstep Development System
software to a directory called \XACT whether it exists or not. If
existing software is already installed in the \XACT directory,
Setup will overwrite the old software with the new software
unless you change the name of the installation directory to be
used by the installation program.
If you are installing Xilinx PRO Series tools, by default, Setup
copies the Viewlogic PRO Series software to a directory called
\PROSER. If existing software is already installed in the
\PROSER directory, you cannot install in the directory unless you
turn on the Force File Overwrite option from the Settings menu.
Note: If you have enough space, Xilinx recommends that you install
the XACTstep software to a new directory. This procedure enables
you to validate the new installation before removing the old
software.
6. Setup will update your AUTOEXEC.BAT file automatically. If it
cannot update it, or if you are installing on a Novell network, refer
to the “Setting Up the Xilinx Environment” appendix for
information on how to update your configuration file manually.
7. Attach the required Xilinx key as described in the next section.
Note: If the key is installed on the same port as an external CD-ROM
drive, attach the drive to the port and then the key to the drive.
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Installing Online Documents and Tutorials
The current release of XACTstep software includes online tutorials
and online documentation. If you are installing Windows software
with the Quick installation option, the tutorials and online
documents included in the package that you selected are
automatically installed on your hard disk drive.
●

To control whether the documents are installed on your hard disk
drive, select the Custom installation option.
To see the list of available documents for each product, select a
package from the Package list-box on the Install screen. Then,
select one of the following products: DS-502, DS-550, or a
Viewlogic product.
The documents and tutorials available for each product are listed
in the Options list box along with the other product options.

●

To control whether the documents are installed on your hard disk
or accessed from the CD-ROM, use the Individual Products
option.
If you want to select the tutorials, the online documents, or both,
use the appropriate options in the Products list box.
Tutorials:
●

●

Run Tutorial from CD runs the online tutorials from the
CD-ROM.
Install Tutorial Locally copies all online executables
and data files onto your hard disk and runs the tutorials from
the PC.

Online Documents:

2-4

●

Read Online Doc from CD, Read Apps Doc from CD,
and Read ProSer Doc from CD run the online
documentation from the CD-ROM.

●

Local Install Online Doc, Install Apps Doc
Locally, and Local Install ProSer Doc copy the
documents on your hard disk.
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Note: To save disk space, Xilinx recommends that you run the
tutorials and documents from the CD.
8. If you selected one of the online documentation options, you are
asked at the end of the software installation if you want to install
the Adobe Acrobat reader.
9. You can either choose to install the reader or cancel the operation.
If you do not install the Adobe Acrobat Reader, you must have it
already installed on your system in order to view the online
documents. For more details, refer to the “Using Xilinx Online
Documentation” chapter.

Using Xilinx Security
When running software on a personal computer, you are required to
install a Xilinx key to run specific products.

New Customers
If you are a new customer, you are provided with a key that includes
50 evaluation runs of the software. You must call Xilinx or your
distributor to obtain a password to enable your key to authorize the
software permanently for a given product or package. Refer to the
“Authorizing a Programmable Key” section for more information.
The Xilinx key only comes with core and package products, such as
DS-502, VLS-STD, and VLS-EXT. If you have a product that comes
without a key, such as X-BLOX (DS-380), Xilinx ABEL (DS-371),
PROcapture (DS-390), or PROsim (DS-290), call Xilinx Customer
Service to obtain a key.

Existing Customers
If you received a product update (SC-502 products), the C key is
already authorized and you do not need to call Xilinx.
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Authorizing a Programmable Key
To authorize your software, follow these instructions.
Note: You can authorize your software from Windows or from DOS.
To authorize software from DOS, refer to the “Using DOS Products”
appendix.
1. Call Xilinx Customer Service to obtain the password for your key.
You will be asked to furnish the key serial number and the names
of the products to be authorized.
To obtain the authorization codes, contact Xilinx Customer Service
from 8:00 a.m. to 5:00 p.m. (Pacific Standard time).
United States and Canada
Europe
Japan
Southeast Asia/All Other Countries
Facsimile Transmission

1-800-624-4782
44-1-932-349401
813-3297-9191
852-2410-2739
1-408-559-0115

International customers may also contact their local sales
distributor or sales representative.
2. Connect the key to a parallel port of your PC.
3. Double-click on the Software Authorization Utility icon
shown in Figure 2-1.

Figure 2-1 Software Authorization Utility Icon
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The Software Authorization dialog box shown in Figure 2-2 is
displayed.

Figure 2-2 Software Authorization Dialog Box
4. Locate the serial number of the key on its case.
5. Enter the serial number in the Serial Number box and the
password in the Password #1 box of the Software Authorization
Utility dialog box.
6. Click on the OK button to submit the password to the system.
The following screen is displayed.

Figure 2-3 Authorizing Your Software
Note: If you have purchased the Xilinx version of PRO Series, ensure
you are not using a Viewlogic key. The Xilinx C key is the only key
that should be attached.
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7. Choose the Show Key Authorization option from the File
menu to check the capabilities of your key.
Figure 2-4 shows a typical authorization screen that is displayed if
you enabled Viewlogic Extended.

Figure 2-4 Displaying Key Authorizations
8. Refer to Table 2-1 to verify that the licensed components of your
products are authorized.
The table shows the mapping between products and the licensed
components that are displayed on your screen when you select the
Show Key Authorization option.
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Table 2-1 Product Feature Mapping Chart
Product

Licensed Component

DS-502

XDE, APR, PPR

DS-371 (Xilinx ABEL)

XABEL

DS-391

None

DS-35

None

DS-OR-STD

XDE, APR, PPR, XBLOX

DS-380 (X-BLOX)

XBLOX

Standard Packages
(DS-3PA-STD, DS-OR-STD, or DS-VL-STD)

XDE, APR, PPR, X-BLOX

Advanced Packages*
(DS-3PA-ADV or DS-VL-ADV)

XDE, APR, PPR, X-BLOX

Viewlogic Stand-alone Base DS-VLS-BAS
(PROcapture and PROsim)

VLS-BAS

Viewlogic Stand-alone Standard DS-VLS-STD
(PROcapture and PROsim)

XDE, APR, PPR, XBLOX, VLS-STD

Viewlogic Stand-alone Extended DS-VLS-EXT
(PROcapture, PROsim, and PROsynthesis)

XDE, APR, PPR, XBLOX, VLS-EXT

Viewlogic Stand-alone Advanced DS-VLS-ADV
(PROcapture, PROsim, and PROsynthesis)

XDE, APR, PPR, XBLOX, VLS-STD

DS-290 PROsim

DS-290

DS-390 PROcapture

DS-390

*. The Foundry components included in Advanced packages use a separate license program. Refer to your
Foundry documentation for information.

Copying Key Information from a File
You can store information for your key in a file and open the
information from the Software Authorization dialog box.
1. Enter the serial number and password information in a file.
2. Select the Open Key Information option from the File menu
and specify the name of the file in which you stored the key
information.
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●

●

●

The first line of the file should be the key serial numebr
followed by a carriage return.
The second line of the file should be the Password followed by
a carriage return.
The third line of the file should be a carriage return (no text) if
there is no second password.

Example of keyfile.dat file:
C1234567
sd579fgdi6f7fklkk75h28

3. Click on the OK button to process the key information.
4. Verify that your key has been authorized for the products you
installed by selecting the Show Key Authorization option
from the File menu. Information similar to the one in Figure 2-4 is
displayed.

Verifying Programmable Key Capabilities
Because all keys come with evaluation runs that enable all software to
run immediately without authorization, you can begin to use the
software without waiting for the authorization password.
To verify the capabilities of your key, perform the following steps:
1. Attach the key to a parallel port of your personal computer.
2. Click on the Software Authorization Utility icon to
display the software authorization screen.

Figure 2-5 Software Authorization Utility Icon
3. Select the Show Key Authorization option from the File menu
of the Software Authorization program shown in
Figure 2-2.
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If you are a new customer using a key that has not been
authorized, this command generates a screen with the
information displayed in Figure 2-6.

Figure 2-6 Non-Authorized Key
Note: The number of evaluation runs reflects the number of free
software evaluation sessions remaining for each product.
If you are an existing customer using a previously authorized key
or if you have just authorized your software, the list of licensed
products is displayed with the corresponding authorizations. For
example, if you have a key authorized for the VLS Extended
package, the following text is displayed:

Getting Started & Installation Guide
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Figure 2-7 Key Authorized for VLS-EXT
Note:
The number of evaluation runs reflects the number of free software
evaluation sessions remaining for each product. The number is not
updated when you install new software.
The number of software evaluation runs for all Viewlogic products
decrements at the same rate. For example, if you use one evaluation
run for the Viewlogic DS-390 product, the number of evaluation runs
for each of the Viewlogic products listed (VLS-BAS,VLS-STD,
VLS-EXT, and DS-290) decreases also.
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Files for Windows Installations
This section lists the files that the XACT and PRO Series programs
install in the /windows and /windows/system directories. It also
lists the files that are installed to execute the tutorials. The files must
exist in the directories indicated below for proper software operation.
Table 2-2 Installation Files for Windows-based Software
Proser or Prosyn Program
\windows
_default.pif
bprogen.pif
bvhdl.pif
bvhdlw.pif
pinsave.pif
sysblock.pif
syscmd.pif
timerpt.pif
xalttmp.pif
xemake.pif

\windows\system
cstext.vbx
gauge.vbx
mh3b200.vbx
mhgchk.vbx
mhgcmb.vbx
mhgdir.vbx
mhgdrl.vbx
mhgfil.vbx
mhgfrm.vbx
mhglbl.vbx
mhgmul.vbx
mhgopt.vbx
mhin200.vbx
mhinint.vbx
mhmq200.vbx
mhrun400.dll
mhsl200.vbx
olecli.dll
sbc.vbx
threed.vbx
toolhelp.dll
vbrun300.dll
vshare.386
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Tutorials

\windows\system \windows\asym\runtime
cmdialog.vbx
ctl3d.dll
ctl3d32.dll
daikon.386
threed.vbx
vbrun300.dll

mtb30anm.sbk
mtb30bas.dll
mtb30bmp.dll
mtb30cmp.dll
mtb30flt.dll
mtb30lnl.dll
mtb30mm.dll
mtb30mm.ini
mtb30net.exe
mtb30run.exe
mtb30utl.dll
pcdxbmp.dll
photo.dll
tbload.exe
pcdlib.dll
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Installing Workstation Products
This chapter covers installation of XACTstep software on a UNIX
workstation. Use the Install program for this type of installation.

Starting the Installation Program
To install software on a Sun4 or HP700 workstation, you can execute
the Install program from a local CD-ROM drive. To install on an
RS6000 or DEC/Alpha workstation, enter the Install command at the
command line as explained in the “Installing on an RS6000 or DEC/
Alpha” section, in this chapter. To install Verilog software, refer to the
“Cadence Verilog-XL” chapter in the XACTstep Version 5.2/6.0 Core
Tools release document.

Accessing a Local CD-ROM Drive
Follow these instructions to access a local CD-ROM drive for
installing your software.
Note: On a Sun workstation, you can access Xilinx online
documentation. You can install the documentation from the Install
program itself. To install the Adobe Acrobat Reader Version 1.0, refer
to the “Using Xilinx Online Documentation” chapter.
1. Check the system requirements defined in the “System
Requirements for Xilinx Software” appendix.
2. Insert the CD-ROM into the drive.
3. Start a window manager (OpenWindows or X-Windows).
4. Execute the platform-specific commands as indicated following.
Note: Workstation users must have root privileges to use mount
commands (# = root prompt, % = user prompt). Directories and

Getting Started & Installation Guide — 0401320 01

3-1

Chapter.book : Chapter.3

2 Mon Sep 25 13:20:08 1995

Getting Started & Installation Guide

device names can vary; therefore, check these names with your
system administrator.
●

On a Sun 4, enter these commands to mount the CD-ROM if it has
not already been mounted:
# mkdir /cdrom_dir↵
# mount -t hsfs -o ro /dev/sr0 /cdrom_dir↵
Type the following to start the Install program:
% /cdrom_dir/install↵

●

On an HP700, enter these commands to mount the CD-ROM if it
has not already been mounted:
# mkdir /cdrom_dir↵
# mount /dev/dsk/3s0 /cdrom_dir↵
Type the following to start the Install program:
% /cdrom_dir/INSTALL.\;1↵
where cdrom_dir is the pathname to the CD-ROM device.

5. Follow the instructions on your screen.
By default, Install copies the software to the /xact directory
whether it exists or not. If you have existing Xilinx software
installed in the /xact directory, Install overwrites the software
with the new software.
If you have enough space, Xilinx recommends that you install
XACTstep Version 5.2 to a new directory. This procedure enables
you to validate the new installation before removing the old
software.
Note: If you are a Mentor Graphics user and do not have Mentor
Graphics Version 8.4 installed, do not install the DS-344 product. If
you are a new customer and do not have a previous installation of the
Xilinx Mentor Graphics Interface (DS-344), you can install the new
interface anywhere. If you have an existing DS-344 installation, you
must overwrite the existing installation with the new interface.
6. Refer to the “Setting Up the Xilinx Environment” appendix for
information on how to update your configuration file with the
proper environment variables.
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Before running the software, you must install and start the
network license manager. If the license manager is not running,
the protected applications try to start it automatically.
7. If you installed a product that requires a license, authorize your
software using the information in the “License Management for
Workstations” section in this chapter. Table 3-1 in the “Adding
New Products” section lists the products that require a license.

Installing on an RS6000 or DEC/Alpha
This section covers installation on RS6000 and DEC/Alpha
workstations using a command you enter from the command line to
initiate an installation script.

Initializing the Install Script
The Install program for the RS6000 and DEC/Alpha workstations
operates with optional command line arguments.
Use the following syntax from the source directory command line.
On an RS6000:
/cdrom_dir/install –source source_dir –target target_dir↵
On a DEC/Alpha:
/cdrom_dir/INSTALL.\;1 –source source_dir –target
target_dir↵
where cdrom_dir is the pathname to the cdrom device.
You can overwrite the source directory with the –source source_dir
argument. If you do not specify this argument, Install retrieves the
source directory from the Install command located on the CD-ROM.
If you did not specify the target directory from the command line
with –target target_dir, the Install program prompts you to enter the
target name. Install also creates a target directory if you did not create
one before installing a product.
The source directory should have an install file and a subdirectory for
either the RS6000 platform (rs6) or for the alpha platform (da1), or for
both platforms. The Install script exits if the platform is not either of
these platforms.
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Each product is stored as a tar file in these subdirectories. The source
directory should include the following subdirectories and tar files:
Source Area/install
./rs6
./rs6/ds391
./rs6/ds380
./rs6/ds401
./rs6/ds502
./rs6/ds550
./rs6/ds500
./da1
./da1/ds391
./da1/ds380
./da1/ds401
./da1/ds502
./da1/ds500

If you want to store more information such as documentation in the
platform subdirectory, add a 'products' file that lists the products
included in the platform subdirectory. If the products file is missing,
type the ls command on the platform subdirectory to identify which
products are present.

Installing Products
After the initial program setup, the following menu is displayed:
Enter the number corresponding to one of the
following options:
1. Install a product
2. Set a different target
3. Exit the Install program
●

Selection 1 displays a list of products as follows :
Please select a product to install. To select a
product, enter the option number.
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1. ds391
2. ds380
3. ds401
4. ds502
5. ds550 (RS6000 workstations only)
6. ds500
After you select a product, the program checks that the disk for
the target is big enough and then installs the product. After
installing a product, Install goes back to the main menu. You can
then choose to install another product.
●

Selection 2 allows you to set a new target installation path and
start again with the main menu without exiting the program. This
feature enables you to install to a larger target disk when you have
selected a disk that is too small; it also allows you to install
different products in different directories.

●

Selection 3 ends the current install session.

After installing the products, authorize your software, referring to
the “License Management for Workstations” section, following.

License Management for Workstations
Workstations do not require a programmable key. Instead, you may
need to contact your Xilinx customer service representative to obtain
authorization codes for your new Xilinx products.
To use XACTstep Version 5.2 software, you must have the following:
●

Highland License Manager, Version 2.4

●

Xilinx license.dat file

●

Appropriate authorization codes for your new Xilinx products

The Highland License Manager and the license.dat file are included
on the media shipped to you by Xilinx and are copied with the
software in your installation directory by the Install program.
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Adding New Products
If you are adding new products, you must call Xilinx to obtain the
authorization codes for the licensed components you purchased. The
components listed in Table 3-1 are the Xilinx licensed programs that
require an authorization code.
Table 3-1 Licensed Components To Be Authorized
Product
Standard Package
Advanced Package
DS-380 (X-BLOX)
DS-371 (Xilinx ABEL)
Mentor Graphics Package or DS-344

Licensed Component
XDE, APR, PPR, XBLOX
XDE, APR, PPR, XBLOX
XBLOX
XABEL
XNF2EDIF

To enable a new installation, you must update your license.dat file
with the authorization codes and start the Highland license server.
To enable an existing installation, you must update the license file,
shut down the license server, and then restart the license server to run
the new version of the Highland software.

Adding a Product Update
If you are an existing XACT customer, your license.dat file is already
enabled for XACTstep Version 5.2. In this case, you do not need to call
Xilinx and edit your license.dat file, unless you are adding new
products. New products have a “DS” prefix. Updates have an “SC”
prefix.
Warning: If this installation is only an update, and no new features
are being added, you must shut down and restart the license server to
run the new version of the Highland software, Version 2.4.

Preparing the License.dat File
If you install software from a CD-ROM, you must edit the file
manually to add the information received from Xilinx.
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The authorization file is in full_path/xact_dir/license/license.dat. The
file includes comments that explain how to add the specific Xilinx
authorization codes.
1. Contact Xilinx Customer Service Monday through Friday, from
8:00 a.m. to 5:00 p.m. Pacific Time to obtain the authorization
codes. International customers may also contact their local sales
distributor or sales representative.
United States and Canada
Europe
Japan
Southeast Asia/All Other Countries
Facsimile Transmission

1-800-624-4782
44-1-932-349401
813-3297-9191
852-2410-2739
1-408-559-0115

2. Provide the host name and host identification of the computer
that will be your license server as well as the product name and
serial number from your registration card.
Note: Save the license agreement card so that you will have the
product name and serial number available in the future. If you
entered your serial number during an installation, you can retrieve it
by executing the following command:
full_path/xact_dir/license/serial.csh↵
You can obtain the host name and host id by logging into the machine
designated as your license server and by executing the following:
full_path/xact_dir/bin/cpu_type/xlmcon hostname↵
full_path/xact_dir/bin/cpu_type/xlmcon hostid↵
where full_path is a user-defined directory, xact_dir is the installation
directory, and cpu_type is alpha, hppa, rs6000, or sparc.
The information just described must be obtained for the machine that
is to be the license server. For example, if you wish an HP 9000/7xx
machine to be the license server for an environment containing
software running on Sun and HP 9000 systems, you would perform
those commands on the HP server.
If your system or network is already running the Highland License
Manager for another Xilinx product, you can also find the
appropriate hostname and hostid on the “SERVER” line of your
current license.dat file. You must use the same server information if
you plan to add new products to your existing server.
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Understanding License Codes
Your Xilinx Customer Service Representative will fax you a file that
includes information similar to the following. This information
enables you to authorize platform-dependent and platformindependent licenses.
SERVER triton 55090a70 2100
DAEMON XXACTD /usr/etc/XXACTD
#
FEATURE

XDE XXACTD 1.000 18-JUL-1995 1 CO11E54C "XSJ"

FEATURE XDE-SUN4 XXACTD 1.000 18-JUL-95 1 CO11E54C "XSJ"
FEATURE

APR XXACTD 1.000 18-JUL-1995 1 60B642A8 "XSJ"

FEATURE APR-SUN4 XXACTD 1.000 18-JUL-95 1 60B642A8 "XSJ"
FEATURE

PPR XXACTD 1.000 18-JUL-1995 1 169ECFF8 "XSJ"

FEATURE PPR-SUN4 XXACTD 1.000 18-JUL-95 1 169ECFF8 "XSJ"
FEATURE

XBLOX XXACTD 1.000 18-JUL-1995 1 58825F70 "XSJ"

FEATURE XBLOX-SUN4 XXACTD 1.000 18-JUL-95 1 58825F70 "XSJ"
##

While platform-independent licenses do not include a platform
suffix, platform-specific licenses consist of a platform-specific suffix
following the product name in the FEATURE line of the license.dat
file.
To authorize all platforms, enter the license string without the
platform name. To authorize a specific platform, enter the license
string for your platform.
FEATURE XDE-SUN4 XXACTD 1.000 18-SEP-95 1 CO11E54C "XSJ"

In this example, XDE is authorized on a SUN4 only.

3-8

Xilinx Development System

Chapter.book : Chapter.3

9 Mon Sep 25 13:20:08 1995

Installing Workstation Products

Adding Authorization Codes
Edit the license.dat file located in the license subdirectory with the
authorization codes received from Xilinx Customer Service.
Note: If your system or network is already running the Highland
License Manager for another Xilinx product, you only need to add
the new Xilinx license information to the existing license file and
restart the license server. In this case, copy only the new FEATURE
lines to the end of the existing Xilinx license file.
1. Add your authorization data as given to you by Xilinx at the end
of the file, observing the following rules.
●

●

●

Entries in the license file must have exactly one line per
feature.
All authorization codes must be entered correctly and in
correct case.
The SERVER, DAEMON, and FEATURE keywords must begin
in the first column of the line.

2. Use the template provided at the end of the license.dat file. The
template shows the case requirements for the various fields.
Failure to follow those rules will cause the license manager to refuse
permission to run the software.
To minimize the risk of typographical errors while entering the
license data, customers in the U.S. who can receive electronic mail
over the Internet can request that their license be e-mailed to them.

Starting the License Server
Once the license.dat file is prepared, start the network license
manager.
Warning: If you have previously installed Xilinx software and are
running the 1.5 or 2.1 version of the Highland License Manager, or
have added new entries into your license file, you must shut down
and restart the license manager. Be sure to run the new version,
Version 2.4, when you restart the Highland License Manager. If this
installation is only an update, and no new features are being added,
you must still restart the license server to run the new version of the
Highland software.
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Start the license manager using the following command
full_path/xact_dir/bin/cpu_type/xlmasu↵
The xlmasu program reads the full_path/xact_dir/license/license.dat
file and sends to the license server machine a command to start the
license manager. You can run xlmasu on the license server machine or
on any machine that can run remote commands on the server
machine.
If you make any changes to the license.dat file after starting the
license manager, you will have to stop and restart the license manager
to enable the changes to take effect.
Any time you need to restart the license manager, you must first run
the xlmdown program to stop the active license manager. Then, run
xlmasu to restart the license manager.

Existing Highland License Manager Users
If your system is already running the Highland License Manager for a
non-Xilinx product, you should run a separate Lmgrd server for
Xilinx programs, using a separate license file. The two servers must
use different socket numbers. The socket number is the last entry on
the SERVER line. The default Xilinx socket number is 2100. Refer to
the example license.dat file shown in the “Understanding License
Codes” section for information on how to define the socket number.
You can change the socket number or the host name without
obtaining new authorization codes: only the hostid is encoded.
Note: Xilinx strongly recommends that you use a separate license file
exclusively for Xilinx licenses and that you use the auto-startup
feature. This feature is enabled by default and allows your licensed
programs to automatically start the license server if the Highland
License Manager is not running. To disable the auto-startup feature,
refer to the $XACT/license/README file.
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Checking the Installation
Verify your installation by checking that the appropriate files are
installed and the required programs are running.
1. Check that your installation directory includes the required
programs and directories listed in the “Programs and Directories”
section at the end of this chapter.
2. Ensure that the required authorization codes are in the license file.
3. The license server communicates with Xilinx-controlled programs
using TCP/IP. If you are using a stand-alone Sun workstation, the
network might not be running the TCP/IP protocol.
Using the ps command at the end of this subsection, check that
TCP/IP is available on your system by verifying that the license
server and any node from which the Xilinx software runs are
running inetd.
If TCP/IP is not running, ask your system administrator to start
the protocol for you.
4. The Xilinx graphical programs are X-Windows based.
Using the ps command at the end of this subsection, check that
the X-server used by the Xilinx graphical programs is running on
the node where the programs are to be viewed:
●

On Sun, the server is usually called “xnews,” “X,” or “Xsun.”

●

On HP-PA and DEC Alpha OSF/1, it is usually “X.”

5. Ensure that the license program and the Xilinx license daemon are
running on the license server node. The license program is called
“lmgrd,” and the daemon is called “XXACTD.” Normally, these
servers are automatically started by the first execution of a
licensed program such as APR, PPR, or XDE.
To check for these required programs, use the ps command and scan
the output for the required programs, as in the following examples:
●

In C shell, enter these commands:
ps axw | grep X | grep -v grep↵

●

In Bourne shell, enter these commands:
ps -eaf | grep inetd

Getting Started & Installation Guide
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Checking the License Server
The programs xlmcon and xlmlog are useful for finding problems
with the license server. They are installed in the full_path/xact_dir \
/bin/cpu_type directory.
1. To check whether the licenses for your programs are enabled, type
the following:
xlmcon quick -a↵
The xlmcon interactive program reports information about the
Highland License Manager and license.dat file.
You can also invoke the xlmcon program by entering the
following:
xlmcon↵
You can use any of the following commands at the xlmcon>
prompt:
●

●

●

●

●

●

●

3-12

hostname reports the current name of the node as understood
by the Highland License Manager.
hostid reports the CPU ID (host identification) of the current
node as understood by the Highland License Manager. Use
this command on the license server computer to be sure that
the ID in the license file is correct. You may not edit the host
identification in the license file; it is encrypted into the
authorization codes for the features.
show prints the license.dat file being accessed in the current
environment; make certain that it contains the Xilinx
FEATURES and XXACTD daemon lines.
list lists all users of the Xilinx features.
verify checks that the encryption of the license is correct and
that there are no typing errors. It does not require that the
license server be running.
quick checks out and checks in the first Xilinx feature in the
license file.
quick -a checks out and checks in all of the Xilinx features in
the license file. This operation must occur while the server is
running.
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2. Check the license manager activity by using the xlmlog program.
To use this program, type the following:
xlmlog↵
If started before the license server, xlmlog reports the following
server startup messages.
xlmasu@zeppo: Xilinx License Manager Autostartup Version #V#
xlmasu@zeppo: License file: /home/venus/xact/license/
license.dat
xlmasu@zeppo: License manager servers will be started on
zeppo
xlmasu@zeppo: Server initialization waiting period started
xlmasu@zeppo: License manager servers were started
successfully on zeppo
xlmasu@zeppo: All license manager servers are now up

In this example, Zeppo is the name of the license server machine,
and /home/venus/xact is the installation directory.

Programs and Directories
Several subdirectories are created in the installation directory,
including the following:
●

/bin — executables (required)

●

/data — data files (required)

●

/xc* — Unified Libraries

●

/examples — example designs

●

/tutorial — tutorial designs

●

/doc — documentation

●

/license — license files. Directory should be writable by all users
(required)

●

/msg message files (required)
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The full_path/xact_dir installation directory also contains the
following files:
●

install — program to perform the installation

●

reminder — information about the Xilinx environment

The following license manager programs are installed in
$XACT/bin/cpu_type when you install licensed programs:

3-14

●

XXACTD — Xilinx license daemon

●

lmdown — network licensing shutdown program

●

lmgrd — network licensing startup program

●

lmhostid — reports network licensing host identification

●

lmremove — network licensing program

●

lmreread — network licensing program

●

lmstat — network licensing status program

●

lmver — network licensing version program

●

xlmasu — network licensing auto-startup program

●

xlmcon — network licensing report program

●

xlmdown — network licensing shutdown program

●

xlmgrd — network licensing program

●

xlmlog — network licensing logging program

●

xlmlsu — network licensing program

●

xlmrmc — network licensing program

●

xlmtee — network licensing program
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Using Xilinx Online Documentation
Xilinx documentation is available online and in hardcopy format. To
access online documentation, you must first install the reader and the
set of documents. Using the Acrobat reader, you can view and search
information in certain online manuals and application notes.
●

If you have a PC, the Xilinx Setup program enables you to
automatically install the Adobe™ Acrobat™ reader with search
capabilities software. If you have already installed the Adobe
reader on your PC using the installation program, refer to the
“Opening Documents with Acrobat Reader” section, in this
chapter.

●

To install the reader manually on a PC or on a Sun workstation,
continue with the “Installing the Acrobat Reader Manually”
section, following, then continue with the “Opening Documents
with Acrobat Reader” section.

Installing the Acrobat Reader Manually
Follow the instructions outlined in this section to install the Adobe
Acrobat reader manually.

Installing on a PC
Version 2.0 of the Acrobat LE Reader is automatically installed by the
Xilinx Setup program if you chose to use online documentation. Refer
to the “Installing PC Products” chapter and to the “Accessing Your
CD-ROM” appendix for details.
Note: Installation of the Acrobat reader requires 2.5 MB of hard disk
space. Moreover, the appearance of the online documents varies with
the performance and resolution of the monitor you use.
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1. Insert the CD-ROM into a drive and determine the source drive
letter. This installation guide assumes that d: is the CD-ROM
drive. If it is different on your system, substitute accordingly for
the following instructions.
2. Select File ➝ Run from the Windows Program Manager.
The Run dialog box is displayed.
3. Type the following in the Run dialog box to install the Acrobat
reader.
d:\acrobat\disk1\setup.exe
The Acrobat Exchange Installer screen shown in Figure 4-1 is
displayed.

Figure 4-1 Acrobat Exchange Installer Screen
4. After reading the agreement, click on the Accept button if you
agree to the terms outlined in the license agreement.
The next screen that is displayed enables you to select the Adobe
products to be installed.
5. Select the Adobe Type Manager 3.0 option, as shown in
Figure 4-2. The fonts are necessary to view the documents.
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Figure 4-2 Selecting Adobe Type Manager
6. Click on the Install button to install the selected products.
A confirmation screen, shown in Figure 4-3, is displayed. From
that screen, you can also change the target installation path.
7. Click on the Install button to confirm that you want to install
the products in the specified target directory.

Figure 4-3 Confirming Installation
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Note: If you want to install the document files on your host
computer, copy the *.pdf files in the \xact\online\docs,
\xact\online\databook, and \proser\online\proser directories from
the XACTstep Version 5.2/6.0 CD-ROM to the local hard disk drive.

Installing on a Workstation
Version 1.01 of the Acrobat reader is available on Sun workstations2
only. Use the instructions outlined in this section to install the
Acrobat software on a Sun. Installation of the Acrobat reader requires
SunOS Version 4.1.3, OpenWindows Version 3.0 (or greater) or Motif,
and 14 MB of disk space.
1. Insert the CD-ROM disk into the CD-ROM drive.
2. Go to the CD-ROM directory as follows:
cd /cdrom_dir/acrobat/readers/sun↵
3. Type the following command to install the Acrobat reader:
./install.rdr↵
For more information, print the Getting Started Guide Postscript file
located in the /cdrom_dir/acrobat/readers/sun/getstart.ps
directory.
Note: If you want to install the document files on your workstation,
copy the *.pdf files in the /xact/online/docs and xact/online/
databook directories from the XACTstep Version 5.2/6.0 CD-ROM to
the local hard drive.

1. This version has viewing and searching limitations that will be addressed in
Version 2.1 of that product. The new version will be sent to you in a future update.
2. Other platforms will be supported in later releases.
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Opening Documents with Acrobat Reader
To view online documentation, follow the instructions in this section.
These instructions assume that the XACTstep Version 5.2/6.0
CD-ROM is mounted on your drive and that you have installed the
Adobe reader on your hard disk drive either from the installation
program or manually, as explained in the “Installing the Acrobat
Reader Manually” section.
Note: The appearance of the online documents varies with the
performance and resolution of the monitor you use.

PC Installations
To view documents on a PC, follow these instructions.
1. Double-click on one of the documentation icons —Xilinx Online
Docs, Xilinx Apps Info, or PRO Series Online Docs — or open one
of the three link page files — linkpage.pdf, dblink.pdf, or
prolink.pdf.

Figure 4-4 Xilinx Online Documentation Icons
The specified link page is displayed, as shown in Figure 4-6,
listing the available documents.
2. Select the book or application note you want from the link page.
Note: Alternatively, you can double-click on the Acroread icon,
shown in Figure 4-5, to start the reader. The Acroread icon is located
in the Acrobat program group. Open a document by selecting File
➝ Open from the Adobe reader, specify the path corresponding to the
type of documentation you want to list, and open the .pdf file
corresponding to the document you want to view.
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Figure 4-5 Acroread Icon
●

To view Xilinx Online Documents on the CD, open the file:
d:\xact\online\docs\linkpage.pdf

●

To view Xilinx Application Information on the CD, open the file:
d:\xact\online\databook\dblink.pdf

●

To view PRO Series Online Documents on the CD, open the file:
d:\proser\online\proser\prolink.pdf

Workstation Installations
To view documents on a workstation, follow these instructions.
1. Type Acroread at the command line to start the reader.
When you start Acrobat Reader, the Viewer screen is displayed.
2. To open a document, select File ➝ Open from the Adobe Reader.
The Open file dialog box is displayed.
3. Specify the path for the link page file corresponding to the type of
documentation you want to view.
To view Xilinx Online Documents, open the file:
/cdrom_dir/online/docs/linkpage.pdf
To view Xilinx Application Information, open the file:
/cdrom_dir/online/databook/dblink.pdf
The specified link page is displayed, as shown in Figure 4-6,
listing the available documents.
4. Select the book or application note you want from the link page.
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Viewing Documents with Acrobat Reader
This section briefly describes how to navigate through the Xilinx
online documentation using the Acrobat Reader with search
capabilities and how to adjust the size of the document page on your
screen. To view non-Xilinx documentation, refer to your Adobe
Acrobat documentation.

Opening an Online Book
After installing the reader and accessing a link page, use the
following instructions to open and view documents.

DESIGN MANAGER • FLOW ENGINE

REFERENCE/USER GUIDE

FLOORPLANNER

REFERENCE/USER GUIDE

TIMING ANALYZER

REFERENCE/USER GUIDE

HARDWARE DEBUGGER

REFERENCE/USER GUIDE

PROM FILE FORMATTER

REFERENCE/USER GUIDE

X-BLOX

REFERENCE/USER GUIDE

DEVELOPMENT SYSTEM VOLUME 1

REFERENCE GUIDE

DEVELOPMENT SYSTEM VOLUME 2

REFERENCE GUIDE

DEVELOPMENT SYSTEM VOLUME 3

REFERENCE GUIDE

DEVELOPMENT SYSTEM

USER GUIDE

HDL SYNTHESIS FOR FPGAs

DESIGN GUIDE

HARDWARE & PERIPHERALS

USER GUIDE

LIBRARIES

GUIDE

LIBRARIES SUPPLEMENT

GUIDE

XEPLD

DESIGN GUIDE

XEPLD SCHEMATIC

DESIGN GUIDE

XEPLD SCHEMATIC (FOR WINDOWS)

DESIGN GUIDE

XEPLD

REFERENCE GUIDE

XEPLD (FOR WINDOWS)

REFERENCE GUIDE

XEPLD VIEWSYNTHESIS

DESIGN GUIDE

™

ONLINE

The link page displayed in Figure 4-6, lists the documents that are
available from the Xilinx Online Docs link page.

Figure 4-6 Link Page for the Xilinx Online Docs (linkpage.pdf)
1. From the link page, select the document you want to access by
clicking on the appropriate title.

Getting Started & Installation Guide

4-7

Chapter.book : Chapter.4

8 Mon Sep 25 13:20:08 1995

Getting Started & Installation Guide

The cover page of the selected document and its Overview Area
are displayed. From the cover page, you can jump to the table of
contents, to the index of the book, or back to the link page. You
view a document by accessing topics for that document either
from the table of contents and index, or from the bookmarks in the
Overview Area.
Note: To view PRO Series online documents on the PC and to view
any documents on Sun workstations, click on the bookmarks listed in
the Overview Area, left of the document page. The table of contents
and index pages are for reference only and do not include any active
links. In the case of Sun workstations, these limitations are due to
viewing limitations of Version 1.0 of the Acrobat Reader that will be
addressed in Version 2.1.

Overview Area

Level Arrows

Cover Page

Figure 4-7 Cover Page and Overview Area (Left)
2. Click on the Table of Contents or Index entry on the cover
page of the book to access the list of linked topics for that book.
Alternatively, you can select a topic from the Overview Area, left
of the document page.
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In a document, the entries in the table of contents, the numbers
next to the entries in the index, cross-references to tables and
figures are all active links.
3. To access a linked topic, park the mouse pointer, which is
displayed as a hand against your document, over a live link.
The mouse pointer changes into a finger, indicating a selectable
link.
4. Click on the desired entry to jump to the topic linked to that entry.
The corresponding document page is displayed.

Closing the Overview Area
When you open a document, the Overview Area, which is a list of
entry points to access parts of a document, is displayed by default.
Use the Page Only button, shown in Figure 4-8, to close the Overview
Area of the window.

Figure 4-8 Page Only Button

Displaying Bookmarks
Use the Bookmarks and Page button, shown in Figure 4-9, to open the
Overview Area next to the document page and display a list of
bookmarks for that document. The Overview Area is a hierarchical
table of contents made of bookmarks. Bookmarks constitute a list of
access points to topics of interest in a document.

Figure 4-9 Bookmarks and Page Button
Click on a bookmark to jump to the location marked by the
bookmark.
A bookmark preceded by a right level arrow indicates an underlying
list of bookmarks. Click on the level arrow to view the underlying
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level of bookmarks. The arrow changes into a down arrow. To hide
the lower level of bookmarks, click on the down level arrow.

Unfolded Level

Folded Level

Figure 4-10 Level Arrows for Bookmarks

Iconizing Document Pages
Use the Thumbnails and Page button, shown in Figure 4-11, to open
the Overview Area and display thumbnail images for each document
page next to the current document page area.

Figure 4-11 Thumbnails and Page Button
To access a page marked by a thumbnail, click on the appropriate
thumbnail.

Viewing an Oversized Document
Use the Hand button, shown in Figure 4-12, to move an oversized
document page on the screen and view different parts of the current
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page that are hidden from view. Drag the hand tool in the direction in
which you want to move the page.

Figure 4-12 Hand Button

Changing the Size of the Document Page
Use the Zoom buttons, shown in Figure 4-13, to magnify or reduce
the page display by a factor of 2. The status bar displays the size of
the document.

Figure 4-13 Zoom Buttons

Selecting Text
Use the Select Text button, shown in Figure 4-14, to select text in a
document. After selecting the text, copy it to the Clipboard using the
Edit → Copy command. To select graphics in a document, click on
the Tools → Select Graphics command.

Figure 4-14 Select Text Button

Browsing a Document
Use the Browse buttons, shown in Figure 4-15, to display the first
page (cover page) or last page (trademark page) of a document and to
navigate backwards or forwards in the document, one page at a time.

Figure 4-15 Browse Buttons
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Retracing Your Steps in the Document
Use the Go Back and Go Forward buttons, shown in Figure 4-16, to
move back in a document and redisplay the document pages that you
have viewed. These buttons can also take you back to previous
documents you have viewed.

Figure 4-16 Go Back and Go Forward Buttons

Displaying the Page Using the Default Size
Use the Actual Size button, shown in Figure 4-17, to display the page
at the default size, 100 percent.

Figure 4-17 Actual Size Button

Adjusting the Page Size to Fit the Window
Use the Fit Page button, shown in Figure 4-18, to adjust the size of the
page so that it fits in the Acrobat Reader window.

Figure 4-18 Fit Page Button

Adjusting the Page Width
Click the Fit Width button, shown in Figure 4-19, to adjust the page
width so that it fills the width of the Acrobat Reader window. Click
this button while holding down the Control key to view the page
across the window without its margins.

Figure 4-19 Fit Width Button
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Finding Information
Use the Find button, shown in Figure 4-20, to search for a word, part
of a word, or multiple words in a document.

Figure 4-20 Find Button

Searching for Information (PC Only)
Use the Search Button, shown in Figure 4-21, to search indexed PDF
documents and generate a list of occurrences of a particular word, a
part of a word (Word Stemming), the sound of a word (Sounds Like),
the meaning of a word (Thesaurus). You can also search a word by
matching the case of the word (Match Case) or search words that
occur in proximity to one another (Proximity). Then, use the Search
Results button to display the list.

Figure 4-21 Search Button
Note: To do a full-text search, you must first load the compiled
indexes for the set of books you are using by clicking the Indexes
button on the Adobe Acrobat Search dialog box. See Figure 4-22. The
index files for each group of online documents are as follows:
●

Xilinx Apps Info: \xact\online\docs\onlinedb.pdx

●

Xilinx Online Docs: \xact\online\databook\online.pdx

●

PRO Series Online Docs: \proser\online\proser.pdx
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Figure 4-22 Search Dialog Box

Displaying Search Results (PC Only)
Use the Search Results button, shown in Figure 4-23, to display the
results of your search.

Figure 4-23 Search Results Button
The name of the document in which the word occurs, appears in the
Search Results dialog box, as shown in Figure 4-24.

Figure 4-24 Search Results Dialog Box
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Browsing Search Results (PC Only)
Use the Browse Search Results buttons, shown in Figure 4-25 to jump
to the documents listed in the Search Results dialog box and view the
pages of documents that include matches for your search.

Figure 4-25 Browse Search Results Buttons

Documentation Categories
This section covers the types of online documents available for use
with Xilinx products. The following types of documents are available
online or in hardcopy format.

Xilinx Apps Info
Refer to the link page of the Xilinx Apps Info set of documents for a
list of application notes that are available online. The same
application notes are part of The Programmable Logic Data Book.

Xilinx Online Docs
This category refers to documents available online or in hardcopy
format.
●

Reference/User Guides for XACTstep 6.0 and 5.2 software

●

Interface software libraries guides

●

Reference/User Guides for XEPLD 6.0 and 5.2 software
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Table 4-1 XACTstep 6.0 Core Software Manuals (Windows)
Reference/User Guides
Design Manager/Flow Engine Reference/User Guide
This manual describes the Design Manager, a tool for managing multiple implementations of a same design allowing you to easily retarget designs to devices and to choose
the best logic implementation for each design you create. It also describes the Flow Manager, which implements designs, and explains how to interact with other programs that
run in the Design Manager environment; namely, the Floorplanner, the Design Editor,
the Timing Analyzer, the Hardware Debugger, the PROM File Formatter, and the PROM
Programmer.
Floorplanner Reference/User Guide
This manual explains how to use the Windows-based graphical user interface to place
the logic of your design manually before or after running PPR.
Timing Analyzer Reference/User Guide
This manual explains how to display post-routing delays along specific paths or all paths
in your design.
Hardware Debugger Reference/User Guide
This manual describes how to program, verify, and debug FPGA devices. It describes the
XChecker cable and explains how to connect the cable pins to your target device for various functions: downloading, verification, and debugging. It also includes a tutorial for
debugging a design using the demonstration boards as target devices.
PROM File Formatter Reference/User Guide
This manual explains how to use a Windows-based tool to format bitstream files into
HEX format files compatible with Xilinx and third-party PROM programmers. You use
the PROM files to program a PROM device, which is then used to configure daisy chains
of one or more FPGAs for one application (configuration) or several applications (reconfiguration).
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Table 4-2 XACTstep 5.2 Core Software Manuals (UNIX/DOS)
Reference/User Guides
Development System User Guide
This guide describes the Xilinx design flow, including design entry, implementation, and
verification. It also addresses design entry methodology selection, configuration modes
as well as readback and verification. This guide also describes boundary scan for XC4000
devices.
Development System Reference Guide, Vol 1, 2, and 3 (DOS and Workstations)
This book describes the XACTstep Development System software, which includes programs to generate XNF files, LCA files, and BIT files. The book covers all the program
options and files that are generated by these programs.
Floorplanner Reference/User Guide (Workstations)
This manual explains how to use the graphical user interface to place the logic of your
design manually before or after running PPR.
HDL Synthesis for FPGAs Design Guide
This guide addresses design synthesis of HDL-based designs. It also provides coding
tips to optimize design implementation.
Hardware & Peripherals User Guide (DOS and Workstations)
This guide describes the Xilinx demonstration boards, the HW-112 Programmer, XPP,
and the XChecker program and cable.
Table 4-3 Interface Software Libraries Manuals
Reference/User Guides
X-BLOX Reference/User Guide
This guide describes the high-level modules you can use to speed up design entry and
the attributes that support logic synthesis. It also explains how to use the X-BLOX program to create designs and the different types of logic synthesis completed by the
X-BLOX program.
Libraries Guide
This book describes the modules of logic, or macros, that you use to create your designs
as well as the attributes and constraints used to process macros during logic implementation. It also discusses relationally placed macros (RPMs), which are macros that contain
relative location constraints (RLOC) information. The XACTstep libraries enable you to
convert designs easily from one family to another.
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Reference/User Guides
Libraries Supplement Guide
This book describes the primitives and the macros that you use to create XC5200 and
XC4000E designs. It also describes the attributes and constraints used to process the
designs during design implementation.
Table 4-4 XEPLD 6.0 Core Software Manuals (Windows)
Reference/User Guides
XEPLD Reference Guide for Windows
This guide describes the XEPLD version of the Design Manager. The Design Manager is
used to manage multiple implementations of a same design. The manual explains how to
implement your design using schematic entry, behavioral entry, or synthesis. It also
describes how to interact with the Flow Manager, and the Timing Analyzer.
XEPLD Schematic Design Guide for Windows
This guide covers design techniques for schematic entry tools. It also includes information to embed behavioral modules and migrate designs between different families.
Table 4-5 XEPLD 5.2 Core Software Manuals (UNIX)
Reference/User Guides
XEPLD Reference Guide
This book describes the XEPLD Development System software, which includes programs to create XNF, JEDEC, VMH, and HEX files. It also addresses schematic design
entry, behavioral design, and the PLUSASM language.
XEPLD Design Guide
This guide covers behavioral design implementation for XC7000 devices. It also includes
PAL design conversion.
XEPLD Schematic Design Guide
This guide covers design techniques for schematic entry tools. It also includes information on how to embed behavioral modules and migrate designs between different families.
XEPLD ViewSynthesis Design Guide
This guide covers logic synthesis for EPLD designs.
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Viewlogic PRO Series Online Docs
The online documents available for the Viewlogic PRO Series include
the design analysis and design entry books.
Table 4-6 PRO Series Manuals (Windows)
Reference/User Guides
PRO Series: Design Entry
This book contains the following manuals:
•Using PRO Series
•PROcapture User’s Guide
•PROcapture Reference Manual
•PCB Interface User’s Guide
•PRO Series Utilities
•PROgen User’s Guide
•EDIF User’s Guide
PRO Series: Design Analysis
This book contains the following manuals:
•PROsim User’s Guide
•PROsim Reference Manual
•PROwave User’s Guide
•PROwave Reference Manual
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Chapter 5

Disk Space Management
This chapter covers disk space management techniques. In particular,
it explains how to decide which software programs you should
install with the Custom Install program and how to use the Custom
Install option of your installation program.

Installation Tips
This section explains how to install only the software required to
support the particular FPGA or EPLD devices you intend to use. You
should use the Custom Install program for this type of installation.
Following these guidelines can save many megabytes of disk space.
1. If you are installing a package, the following products are
displayed in the product selection box of both the Quick and
Custom Installation screens:
●

Third-party interface products

●

FPGA core tools

●

EPLD core tools

●

X-BLOX

2. Choose FPGA core or EPLD core depending upon the devices you
will be using.
3. Choose X-BLOX only if you plan to use the X-BLOX product.
4. Install a third-party interface product and only the library or
libraries you need.
●

XC2000 library

●

XC3000 library (XC3000, XC3000A/L, XC3100, and XC3100A)

Getting Started & Installation Guide — 0401320 01

5-1

Chapter.book : Chapter.5

2 Mon Sep 25 13:20:08 1995

Getting Started & Installation Guide

●

XC4000 library

●

XC5200 library

●

XC7000 library

●

X-BLOX library

5. When installing FPGA core from the Standard Package or DS-502,
select only the device support options that you need.
For example, if you intend to design an XC3042A device using
Viewlogic but might be upgrading to an XC3064A at a later time,
you could install the following selection of products:
DS502:
●

FPGA Core Tools

●

XC3000A/XC4000 Place and Route

●

Design Manager

●

Hardware Debugger

●

PROM File Formatter

●

Floorplanner

●

Timing Analyzer

●

PROM Programmer

●

XC3000A/XC4000 Place and Route

●

XACT Design Editor

●

XChecker Download/Readback

●

XPP PROM Programmer

●

Example files

●

XC3042A, XC3042L, XC3142A support

●

XC3064A, XC3064L, XC3164A support

Note: You can install the XC3064A files now or at the time you decide
to use them.
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DS290:
●

PROsim and interface

●

XC3000 Library

●

X-BLOX Library

DS390:
●

ViewDraw and interface or PROcapture and interface

In this example, the XC3000 and X-BLOX libraries are only selected
once, since they are the same in the DS-290 and DS-390 packages. You
only need to select them once, but a multiple selection would do no
harm.

Customizing Your Installation
The Custom Install option provides for disk space management
capabilities by enabling you to do the following:
●

Specify different paths for the different products that constitute
your software package.

●

Install only the parts of the software product you will be using.

●

Use the disk space analysis features of the Install program to
determine where to install your software.

Custom Install Screen
Follow these instructions to access the Custom Install screen.
1. Select Custom from the Main Window.
The screen appears as shown in Figure 5-1.
2. In section 1 of the installation screen, click on the down arrow
located to the right of the selection box.
A list of products or packages appears.
3. Select the products you wish to install by clicking on the
appropriate item on the list.
4. Set the YES/NO selection status for the products and options you
wish to install.
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5. Click on Set Path to set different paths.

Figure 5-1 Custom Installation Screen

Set Path Screen
The Set Path window allows you to review the list of products that
you can install on your system and the space requirements for each
product.

5-4

●

Path indicates the destination directory for the product.

●

Prdct Sz (Product Size) indicates the total size of the program in
megabytes (MB).

●

Need indicates the required disk space for the product
installation. This space can be less than the product size if you
already have an installation of the product in the displayed path.
If you reinstall the product, older files are replaced.

●

Analyze Disk Space enables or disables disk space analysis.
This feature allows you to determine if you have enough space on
your system to install software, and if you do not have enough
space, the feature tells you how much space you need. When this
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feature is turned off, you can save processing time. Figure 5-2
shows the Set Path screen with the Analyze Disk Space option
turned on.

Figure 5-2 Set Path Window with Analyze On (PC Screen)
You can edit a path or set your installation to different directories as
follows:
1. Highlight a product in the product selection box, then click on the
Edit Path button.
The Edit Path window appears and displays the installation paths
for the selected products.
2. You can choose to edit your path by clicking on the path shown in
the selection box or return to the previous screen by clicking on OK
or Cancel.
PC and workstation Set Path screens differ slightly. PC screens
include a Drive Status section showing available space on all drives
(Current), required disk space to complete the installation (Need),
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and remaining space after completing the installation (Left). When
Analyze Disk Space is turned on, the Drive Status section on the PC
uses the “Need” values of each drive. Refer to Figure 5-2.

Overwriting Existing Files
If you have existing Xilinx products, Xilinx recommends that you
install to a new directory provided you have enough disk space. If
you install new software in a directory that contains old software,
Install overwrites the old software without warning you.
The only time Install and Setup ask you if you wish to overwrite
software is when you are installing older files over newer ones. To
overwrite software unconditionally, use the Force File Overwrite
option of the installation program.

Force File Overwrite
The Force File Overwrite option is in the Settings menu. By default,
this option is turned off and the installation program does not install
old files over new ones.
There might be times when you need to install all the files on your
media regardless of the file date:
●

If you modified the dates of the files of a previous installation

●

If you install a file from the bulletin board

Use the Force File Overwrite option to overwrite the files without
being prompted by the system to confirm this operation.
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Appendix A

System Requirements for Xilinx Software
Before installing the software, verify that your system meets the
requirements outlined in this appendix. Alternatively, you can run
the software directly from your CD-ROM. Refer to the “Accessing
Your CD-ROM” appendix for more information.
Note: If you have an Advanced package, which includes XACT
Foundry 7.0 software, such as one of the Viewlogic Advanced
packages or the Third-Party Alliance Advanced package, use a
separate installation program to install it. Refer to the Xilinx XACT
Foundry 7.0 Installation Guide provided with these products for
system requirements and installation instructions.

Disk Space
To install the XACTstep Development System Tools for FPGA and
EPLD devices and one of the supported interfaces, you need
approximately 80 to 180 MB, depending on which options you
choose. Table A-1 indicates approximate space requirements for each
software product.
Disk space requirements for specific products are indicated during
the installation program execution. The “Disk Space Management”
chapter offers installation tips that can save disk space.
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Table A-1 Disk Space Requirements
Software
FPGA Core
EPLD Core
PRO Series PROcapture and PROsim
PRO Series PROsynthesis
Viewlogic Interface
OrCAD Interface

Approximate Space
Requirements (MB) a
30 to 100
30
20
14
7 to 16
20

a. The actual space required to install these tools is dependent on which devices
and features you install. Refer to the “Disk Space Management” chapter for information on how to install a subset of the product features.

PC System Requirements
PC systems require the following:
●

IBM-compatible PC 486 or Pentium

●

DOS 5.0 or later operating system

Note: The Doublespace program that is shipped with DOS 6.0 is not
reliable. Xilinx recommends that you upgrade to DOS 6.21 or 6.3.
●

MS Windows 3.1 or later to run the Xilinx Setup program

●

WIN32S 1.25.142.0 or later, provided on the Xilinx CD-ROM

Note: You can check the version number of your WIN32s program in
the \windows\system\win32s.ini file.
●

VShare.386 for PRO Series installations only, provided on the
Xilinx CD-ROM

Note: Win32s and VShare.386 are owned and developed by Microsoft
Corporation.
●

RAM memory:
The following table indicates the recommended memory for
implementing your FPGA and EPLD designs. Memory
requirements are environment and design dependent. The
Windows operating system adds additional memory overhead, as
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do any active Windows applications. Whereas some designs can
be implemented using less than the specified memory, other
complicated or large designs may require additional memory.
Table A-2 Recommended Memory and Swap Space
Recommended
Memory

Recommended
Windows Swap Space

16 MB RAM

16 MB

XC2000 (all devices)
XC3x20x — XC3x42x (all variants)
XC7000 (all devices)
XC3x64x — XC3x90x
XC4002x — XC4006x (all variants)
XC5202 — XC5204

32 MB RAM

32 MB

XC3195x (all variants)
XC4008x — XC4013x (all variants)
XC5206 — XC5210 (all variants)

Device Ranges

Note: When running XACTstep Version 6.0, 460 KB of free
conventional memory is recommended. This number reflects the free
conventional memory available while Windows is running.
●

VGA graphics card

●

One parallel and two serial ports (one for the mouse and one for
the serial download cable)

●

Windows-compatible mouse

●

Xilinx recommends that you have FILES and BUFFERS set to a
minimum of 25 in the CONFIG.SYS file

In addition, the following requirements must be met to run the
installation program.
●

ISO9660 CD-ROM drive

●

At least 4 MB of disk space on the hard disk drive to run the Xilinx
Windows Setup program. If you are using the DOS Install, you
need 2 MB.

●

8 MB of RAM memory
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Note: Setup, the Xilinx installation program for Windows, supports
both Novell and PC-NFS networks; however, if you install software
from a CD-ROM and you use a Novell network, you must use Novell
3.12 or higher. The installation program for DOS programs supports
Novell networks only.

Workstation System Requirements
Workstations require the following:
●

Workstation types:
●

Sun4 (SPARC) with SunOS 4.1.x

●

HP-PA 9000 (RISC) Model 700 with HP-UX 9.05

●

IBM RS6000 with AIX 3.2.5

●

DEC Alpha AXP with OSF/1 Version 1.3 or 3.0

●

RAM: 64 MB (recommended)

●

Swap space: 75 MB

●

TCP/IP software

●

Display: X-Windows

In addition, the following requirements must be met to run the Install
program using a CD-ROM.

A-4

●

CD-ROM drive: ISO9660

●

Disk space: 10 MB

●

RAM memory: 32 MB
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Appendix B

Accessing Your CD-ROM
This appendix explains how to run software directly from your
CD-ROM drive. It also describes how to access a Sun CD-ROM drive
from your PC to install software.

Using an Executable CD-ROM
To run the XACTstep software on your PC directly from the CD-ROM,
configure your PC as explained in this section. This section assumes
that d: is your CD-ROM drive.

Windows and DOS Applications
To configure your PC to run XACTstep under Windows, follow the
steps in this section. This information also applies to DOS
applications.
You must first perform the following steps from DOS before invoking
Windows. You cannot complete these steps from Windows.
1. Edit your AUTOEXEC.BAT file and include in your path the
directories for the software products you will be using.
d:\xact (Core products, X-BLOX, Xilinx ABEL)
d:\orcad (OrCAD products)
For example, if d: is the CD-ROM drive, and you plan to use the
XACTstep tools and the OrCAD products, you must set the path
command as follows:
path=other_paths;d:\xact;d:\orcad;other_paths
2. Set the XACT environment variable for the XACTstep Version 6.0
tools.
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You can either set the variable manually from the DOS command
line by creating and running a batch file, or you can modify and
run the AUTOEXEC.BAT file. The XACT variable must point to
the directories of all the software products that you plan to use.
For example, if d: is the CD-ROM drive and you plan to use the
XACTstep tools and the OrCAD products, set your XACT variable
as follows:
set xact=d:\xact;d:\orcad
3. Create a writable directory on your hard disk drive for the
XACTstep Version 6.0 tools to store user-specific initialization files.
Then, set the XACTUSER environment variable to point to the
directory.
mkdir c:\xactuser
set XACTUSER=c:\xactuser
4. To run PRO Series software, refer to the “Running Viewlogic PRO
Series from CD-ROM” section.
Note: If you are installing XACTstep Development System software
for Windows, you must also set the TEMP variable, because some
XACTstep programs use the same TEMP variable as Windows to store
temporary files. If this variable is not set, and the directory to which it
points is not valid and writable, the software will not run.
●

Create a writable directory to store the temporary files as follows:
mkdir c:\tmp

●

Include the following line in your AUTOEXEC.BAT file:
set TEMP=c:\tmp

●

To verify that the TEMP environment variable is set, type set at
the DOS prompt.

You can then start your software from your hard disk, but the
software really executes from the CD-ROM.
Note: To run your Windows applications from the CD-ROM, create a
Windows group and an icon. Refer to the “Troubleshooting”
appendix for information.
You can access both the tutorials and the online documentation from
the CD-ROM using the Xilinx Setup program. Refer to the “Accessing
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the Online Tutorials” and “Accessing Online Documentation”
sections, in this appendix.

Running Viewlogic PRO Series from CD-ROM
To run the Viewlogic PRO Series from a CD-ROM drive, you must
configure your system properly and set up a program group in
Windows to correctly access the software located on the CD-ROM.

Configuring the System
To configure your system to run Viewlogic PRO Series from a CDROM drive, follow this procedure.
1. If you are running Windows, exit it.
2. Create a local PRO Series directory, as shown in the following
example:
c:\cdproser
3. Create a \standard subdirectory in the local PRO Series directory:
c:\cdproser\standard
4. Create a local XACTstep directory:
c:\cdxact
5. Create a \data subdirectory in the local XACTstep directory:
c:\cdxact\data
6. Copy the partlist.xct file from the CD-ROM XACTstep \data subdirectory to the local XACTstep \data subdirectory:
copy d:\xact\data\partlist.xct c:\cdxact\data
7. Make the following changes to your autoexec.bat file:
set wdir=c:\cdproser\standard;d:\proser\standard
Note: The first directory in the WDIR environment variable must be a
writable directory. This is where the project information will be
written. The second path included in WDIR is the CD PRO Series
\standard directory, which is used by the PRO Series software to find
data files.
set xact=c:\cdxact;d:\xact;d:\proser
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Note: The first directory in the XACT environment variable must
contain a writable version of the partlist.xct data file in its \data
subdirectory. Xilinx PROflow uses this file and fails if you use the CDROM version, which is not writable. The second path included in
XACT is the CD XACTstep directory, which the XACTstep software
uses to locate data files.
set path=d:\xact;d:\proser;other_paths
Note: The only paths added to the PATH environment variable are
the \xact and \proser CD-ROM executable paths. You do not need to
add the local paths created in the previous steps.
set xactuser=c:\cdxact
Note: To ensure that the XACTstep software contains a writable
directory, set the XACTUSER environment variable to a local
directory. Because a local XACTstep directory has already been
created to store a local copy of the partlist.xct file, you can use it as the
temporary file storage area as well.
8. Reboot your machine or execute your autoexec.bat file so that the
new changes take effect.
9. Start Windows.

Creating a CD-ROM Program Group
Now that you have properly configured your system to run the
software from the CD-ROM, all that remains to do is to create a CDROM program group. To create a program icon for Xilinx PROflow,
perform the following steps.
1. To create a new program group in the Program Manager, select the
File ➝ New command.
The New Program Object dialog box appears.
2. Select the Program Group radio box and click on OK.
The Program Group Properties dialog box appears.
3. Enter the name of the new group in the Description text field and
click on OK. For example, type the following:
CDROM XACTstep 6.0
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The new program group is created and displayed in the Program
Manager.
4. To create a new program item in the new group, select File ➝
New.
5. Select the Program Item radio box and click on OK.
The Program Item Properties dialog box is displayed.
6. In the Description text field, type Xilinx PROflow.
7. In the Command Line text field, type d:\proser\psfm.exe.
8. In the Working Directory text field, type c:\cdproser.
Note: It is important that the working directory be located on the
same drive as the projects that will be used in Xilinx PROflow.
9. Click on OK.
10. If you are using a network connection to mount the CD-ROM,
confirm the Network Path Specified dialog box.
The CD-ROM XACTstep 6.0 program group is now updated to
include the Xilinx PROflow program icon.
Note: The procedure just given assumes that c:\ is a local drive and
that d:\ is the CD-ROM drive that contains the XACTstep CD-ROM.

Using Online Tutorials and Online Documents
XACTstep software includes interactive tutorials for Windowscompatible tools. It also includes online documents for Windows PCs
and Sun 4 workstations. You can run both the tutorials and the online
documents from the CD-ROM.
The tutorials include procedures and demonstrations of the
procedures and are invoked either by double-clicking on the
Learning Center icon or by selecting the Online Tutorial option from
the Help menu of each Windows-based software tool.
Refer to the “Installing Online Documents” section of the”Installing
PC Products” chapter for information on how to install these
documents.
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Accessing a Workstation CD-ROM Using PC-NFS
You can access a Sun CD-ROM drive from a PC located on the same
network to install software.
Note: You can install software from a Sun CD-ROM to a PC only if
you are in a PC-NFS environment.
1. If your CD is not already mounted, mount it on the CD-ROM
drive of your Sun workstation as follows:
# mkdir /cdrom_dir↵
# mount -t hsfs -o ro /dev/sr0 /cdrom_dir↵
Note: Workstation users must have root privileges to use mount
commands (# = root prompt, % = user prompt). Directories and
device names can vary; therefore, check these names with your
system administrator.
2. From your UNIX terminal, export the CD-ROM drive with the
following command.
/usr/etc/exportfs –a
Note: Mounting and exporting the CD-ROM drive requires system
administrator privileges.
3. From your PC, mount a drive to the CD-ROM drive using the
following command.
net use pc_drive: sun_node:/cdrom_dir
The pc_drive variable is a PC drive that is not currently in use,
sun_node is the host name of the Sun workstation where the
CD-ROM drive is mounted, and /cdrom_dir is the CD-ROM
mount directory, as shown in the following example.
net use k: cotati:/cdrom
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Appendix C

Setting Up the Xilinx Environment
This appendix explains how to update your configuration file
manually for your computer. It applies to installations performed
with the Xilinx installation program. Refer to the appropriate section
for your type of computer.

Configuring Your Personal Computer
If Install could not update your configuration file, you must update
your AUTOEXEC.BAT file manually before running your software.
Install appends a list of suggested changes to C:\AUTOEXEC.XLX.

Updating the Environment Variables
Ensure that you set the environment variables and installation
directory as specified in this section.
When manually modifying the AUTOEXEC.BAT file, do not include
any space characters in the definition of the environment variables,
either before or after the equal sign, or at the end of the line. Spaces
prevent the software from finding the necessary data files.

Novell Network Installations
If you are installing on a Novell network, ensure that your XACT
environment variable points to an explicit path:
set XACT=n:.

(Incorrect)

set XACT=n:\full_path\xact

(Correct)
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XACTstep Development System and OrCAD
Installations
To update your AUTOEXEC.BAT file for the XACTstep Development
System software or the OrCAD interface, use the following
guidelines.
1. If you are running Windows, exit Windows.
2. Ensure that in your AUTOEXEC.BAT file, the installation
directories for the software products you will be using (for
example, c:\xact and d:\orcad) are included in both the path and
the XACT environment variable.
For the example where c:\xact and d:\orcad are used as the
installation paths, the lines in the AUTOEXEC.BAT file would
read as follows:
path=other_paths;c:\xact;d:\orcad; other_paths
set XACT=c:\xact; d:\orcad
Only the executable directory must be in the Path statement to
satisfy Xilinx software requirements. Only the data directory must
be included in the XACT environment variable.
3. Create a writable directory on your hard disk drive for the
XACTstep Version 6.0 tools to store user-specific initialization files.
Then, set the XACTUSER environment variable to point to the
directory.
mkdir c:\xactuser
set XACTUSER=c:\xactuser
Note: If you are installing XACTstep Development System software
for Windows, you must also set the TEMP variable, because some
XACTstep programs use the same TEMP variable as Windows to store
temporary files.
●

Create a writable directory to store the temporary files as follows:
mkdir c:\tmp

●

Include the following line in your AUTOEXEC.BAT file:
set TEMP=c:\tmp

C-2

Xilinx Development System

Chapter.book : apxc

3 Mon Sep 25 13:20:08 1995

Setting Up the Xilinx Environment

●

To verify that the TEMP environment variable is set, type set at
the DOS prompt.

4. Reboot the PC after making changes to the AUTOEXEC.BAT file
or simply execute the AUTOEXEC.BAT file.

Xilinx ABEL Installations
When installing Xilinx ABEL on a PC, install it in the same directory
as the XACTstep tools.
To configure Xilinx ABEL, set your path and XACT environment
variable to point to the installation path, as explained in the
“XACTstep Development System and OrCAD Installations” section
earlier in this appendix. Include the XABEL.EXE executable in your
path and point your XACT environment variable to the Xilinx ABEL
installation directory.
●

If you are installing Xilinx ABEL on top of the XACT software,
that is, in the xact installation directory, XABEL.EXE is in c:\xact
for example. In this case, the path and the XACT environment
variable must include c:\xact. You only need to include the
following information:
PATH=c:\xact
XACT=c:\xact

●

If you are installing Xilinx ABEL to a different directory than the
XACT software, include that information in your path and XACT
variable. For example, you could specify the directories as
follows:
PATH=c:\xact; d:\xabel
XACT=c:\xact; d:\xabel

Xilinx PRO Series Installations
To update your AUTOEXEC.BAT file for the Xilinx PRO Series or
Xilinx PRO Series interface, use the following guidelines.
1. Include the installation directory (for example, c:\proser) in the
PATH variable.
2. The XACT environment variable must include the directory that
contains the \unified directory. By default, the Setup program
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installs the \unified directory in c:\proser.
3. For example, if you are using c:\xact as the XACTstep
Development System path and c:\proser as the Xilinx PRO Series
path, the line in the AUTOEXEC.BAT file must read as follows:
set XACT=c:\xact;c:\proser
4. Set the WDIR environment variable as shown in the following
example.
if c:\proser is used as the installation path, the lines in the
AUTOEXEC.BAT file would read as follows:
path=other_paths;c:\proser;other_paths
set WDIR=c:\proser\standard
5. Reboot the PC after making changes to the AUTOEXEC.BAT file
or simply execute the AUTOEXEC.BAT file.
Note: The PRO Series software cannot be used in conjunction with
any other versions of the Viewlogic Workview 4.1 software. There
cannot be references to Workview in the path and in the WDIR
environment variables.

Increasing Environment Space
The DOS environment space allocated on your PC might be
insufficient to accommodate the new environmental variables.
You can increase your DOS environment space by adding the
following statement to your CONFIG.SYS file.
shell=c:\dos\command.com /p /e:720
The number 720 represents the number of bytes reserved for the DOS
environment and can be replaced by any number.
The “Out of Environment Space” message is often difficult to see. You
can use the DOS Set command to verify that the environment is
loaded correctly. Entering the Set command at the DOS prompt
displays all current environment variables and the path. If anything
defined in AUTOEXEC.BAT is not listed there, you must increase the
DOS environment space.
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Setting the Graphics Mode
As a default, the graphics mode is set to VGA4.
To change the graphics mode, add the GRMODE environment
variable to the AUTOEXEC.BAT file, as follows.
set GRMODE=graphics_mode
These are the acceptable graphics_mode entries:
VGA4

(4-Color VGA 640 x 480)

VGA8

(8-Color VGA 640 x 480)

VGA16

(16-Color VGA 640 x 480)

VGAP4

(4-Color VGA 800 x 600)

VGAP8

(8-Color VGA 800 x 600)

VGAP16

(16-Color VGA 800 x 600)

For a complete list of supported graphics modes, refer to the file
Gl16mode.xct located in your drive:\xact_dir\data directory. You can
also refer to the Gl16mode.prt file located in the same directory for
more information.

Configuring Your Workstation
Before using the Xilinx software, you must configure your
workstation to run the software. This section explains how to update
your .cshrc or .login file if you are using a C shell. The Install
program stores suggested changes in a file called reminder, which is
located in your CD-ROM or tape installation directory.

XACTstep Development System Software
The following explains how to configure your system to run the
XACTstep Development System software.
1. Add the full_path/xact_dir/bin/cpu_type directory to your path.
CPU types include hppa, alpha, rs6000, or sparc.
2. Define the XACT environment variable and set it to the name of
the directory into which you installed the software.
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3. To use XDM and XDE, you must also run an X-Windows display
manager (that is, not a SunView display), and you must include a
DISPLAY environment variable. Define DISPLAY as the name of
your display. DISPLAY is “unix:0.0” normally.
Note: Various X servers have slightly different requirements, but
usually you can use either of the following settings if you are running
software on the machine whose monitor you are using:
setenv DISPLAY :0.0
setenv DISPLAY unix:0.0
4. If you are logged on to a remote machine, use this DISPLAY
setting:
setenv DISPLAY mynode:0.0
where mynode is the name of the system whose monitor you use.
For example, if the software was installed in the /usr/xact
directory and you are running on a SPARC, the .login or .cshrc file
should contain the following:
set path = (/usr/xact/bin/sparc $path)
setenv XACT /usr/xact
setenv DISPLAY unix:0.0
5. You will also need to execute the following command to allow the
remote machine to display graphics on your screen:
xhost + hostname
The hostname is the name of the remote machine you are allowing
to write to your display. If you do not specify the host name and
you type only xhost+, any host on your network can write to your
display screen.
For example, the following syntax allows you to run the software
on the host named bigben and to display the graphics on the local
monitor of the machine called mynode.
setenv DISPLAY mynode:0.0
xhost + bigben
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Running Xhost+ on a Client Machine
To run xhost+ on a client machine, follow these instructions.
1. Run xhost+ on the machine whose screen you are using.
2. Execute the following command on the machine you are logged
into.
setenv DISPLAY hostname:0
The hostname is the name of the host with the screen.

Interface-Specific Updates to the Configuration File
To configure your workstation to run the Viewlogic or the Mentor
Graphics interface software, continue with this section.

Xilinx ABEL Installations
The following three environment variables must be set on the
workstation platform for Xilinx ABEL.
setenv XABELDEV $XACT/data/lib5
setenv XAPPLRESDIR $XABELDEV
setenv UIDPATH ./%U:$HOME/%U:/usr/X11/lib/X11 \
/uid/%U:$XACT/bin/sparc/%U

Viewlogic Interface
Update your .cshrc or .login file by adding the XACT and WDIR
environment variables.
1. Set the WDIR environment variable to point to the directory
where the Viewlogic message (MSG) files will be installed. Xilinx
recommends the following directory:
full_path/xact/workview/standard
2. Add the directory full_path/xact/workview to your path:
set path = (full_path/xact/workview $path)
3. Set the XACT environment variable to full_path/xact:
setenv XACT full_path/xact
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For example, if the software was installed in the /usr/xact directory,
update your configuration file by adding the following lines:
set path = (/usr/xact/bin/sparc $path)
setenv XACT /usr/xact

Mentor Graphics Interface for UNIX Environments
If you have a Sun or an HP workstation with a UNIX environment,
configure your .cshrc or .login file by updating them with the XACT,
LCA, and other environment variables specific to Mentor Graphics.
1. Add the following line to set the LCA environment variable:
setenv LCA ds344_path
where ds344_path is the location of your Xilinx Mentor Graphics
interface.
2. Add the following line to set the XACT environment variable:
setenv XACT ds344_path:full_path/xact
3. Set the MGLS_LICENSE_FILE environment variable to point to
the directory where your license is located.
setenv MGLS_LICENSE_FILE \
mentor_license_path/mentor_license_file
4. Set the MGC_WD environment variable to point to the directory
where your design is located.
For example, if your design is in /home/mentor/work/design,
set the variable as follows:
setenv MGC_WD /home/mentor/work/design
You need to reset this variable every time you change design
directories.
5. Set the optional MGC_GENLIB variable, which points to the
Mentor generic library.
setenv MGC_GENLIB mentor_path/gen_lib
6. Set the MGC_HOME environment variable to point to where you
installed the Mentor Graphics software.
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For example, if you installed that software in /tools/mentor/
idea8.4, set the variable as follows:
setenv MGC_HOME /tools/mentor/idea8.4
7. Set the LD_LIBRARY_PATH as follows:
setenv LD_LIBRARY_PATH mentor_path:openwin_path/lib
where mentor_path is $MGC_HOME and openwin_path is the
location of Openwin.
8. Set the MGC_LOCATION_MAP environment variable to point to
the location of your mgc_location_map file.
For example, if you placed that file in /home/mentor/work/
tools, set the variable as follows:
setenv MGC_LOCATION_MAP \
/home/mentor/work/tools/mgc_location_map
In your mgc_location_map file, you must reference $LCA;
however, do not assign a value to it. The $LCA line must appear
in the file, followed by a blank line. You can also add soft prefixes
in the mgc_location_map file to point to your other designs.
For example, you might add the following entry:
$ourdesigns
/home/mentor/mygroups/designs
This entry allows you to move the specified design among
directories without changing any references to those designs.
Simply change the path to “ourdesigns” in your
mgc_location_map file.
9. Add the ${LCA}/com/cpu_type and ${LCA}/bin/cpu_type
directories as well as ${MGC_HOME}/bin to your path definition.
set path = (${LCA}/com/cpu_type \
${LCA}/bin/cpu_type ${MGC_HOME}/bin $path)
The following illustrates how to configure your .login or .cshrc file for
use with the Mentor Graphics interface. This example assumes you
installed the Core software in /group/usr/xact and the Mentor
Graphics interface software in /group/usr/ds344.
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setenv LCA /group/usr/ds344
setenv XACT /group/usr/ds344:/group/usr/xact
setenv MGC_GENLIB mentor_path/gen_lib
setenv MGC_HOME /tools/mentor/idea8.4
setenv LD_LIBRARY_PATH \
${MGC_HOME}:openwin_path/lib
setenv MGLS_LICENSE_FILE \
mentor_license_path/mentor_license_file
setenv MGC_WD /group/usr/design
setenv MGC_LOCATION_MAP \
/group/usr/project/mgc_location_map
set path = (${LCA}/com/cpu_type \
${LCA}/bin/cpu_type ${MGC_HOME}/bin \
/group/usr/xact/bin $path)

XSI Environment Variables
To run the XSI software, you must configure your .cshrc or .login file
as described in this section.
1. Include the full path for the XSI executables as follows.
set path=(DS-401_v5.2_Dir/bin/platform $path)
Substitute platform for one of the following: sparc, hppa, or rs6000.
2. Add the full path for the XSI installation directory to the XACT
environment variable setting.
Set the following environment variables, depending on your
system configuration/setup.
●

If DS-401 and XACT 5.2 are installed on the same platform but in
different directories.
setenv XACT {DS-401_v5.2_Dir}:{XACT_5.2_Dir}

●

If DS-401 and XACT 5.2 are installed on different platforms.
Enter the following on the DS-401 platform.
setenv XACT {DS-401_v5.2_Dir}
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Enter the following on the XACT 5.2 platform.
setenv XACT {XACT_5.2_Dir}
3. Set a new environment variable, DS401, to the full path of the XSI
installation directory, as follows.
setenv DS401 {DS-401_v5.2_Dir}
Note: For information on how to set up your Synopsys Startup/
Setup files, refer to the “Getting Started” section of the Synopsys (XSI)
for FPGAs Interface/Tutorial Guide or Synopsys (XSI) for EPLDs Interface/
Tutorial Guide.

Getting Started & Installation Guide

C-11

Chapter.book : apxc

12 Mon Sep 25 13:20:08 1995

Getting Started & Installation Guide

C-12

Xilinx Development System

Chapter.book : covapd

13 Mon Sep 25 13:20:08 1995

Getting Started
& Installation
Guide

Using DOS Products

Getting Started & Installation Guide — 0401320 01

Printed in U.S.A.

Chapter.book : covapd

14 Mon Sep 25 13:20:08 1995

Getting Started & Installation Guide

Xilinx Development System

Chapter.book : apxd

1 Mon Sep 25 13:20:08 1995

Appendix D

Using DOS Products
If you plan to use XACTstep on a PC running DOS only, use the Install
program and follow the installation instructions outlined in this
appendix. This appendix explains how to install and authorize DOSonly software from DOS and how to run the DOS-based XACTstep
products from an MS-DOS shell in Windows.

Copying an Individual Product onto a Diskette
You can take an individual product and copy it onto a diskette.
1. Select a product from the following table. Each selection is a text
file that includes a list of files to copy and the directory to which
you should copy the files.
Table D-1 DOS Files and Installation Directories
Product

Directory

ds290.txt

PROSER

ds35.txt

XACT

ds371.txt

XACT

ds380.txt

XACT

ds390.txt

PROSER

ds391.txt

PROSER

ds502.txt

XACT

ds550.txt

XACT

2. From the C:\ drive, type the following syntax to copy the files for
the selected product to the diskette.
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d:\install product_name destination_path
where product_name is any one of the products listed in Table D-1
and destination_path is your target diskette drive and one of the
two possible installation directories in Table D-1.

Installing Software from Diskettes
This section covers installation from diskettes.
1. Check the system requirements defined in the “System
Requirements for Xilinx Software” appendix.
2. Insert the CD-ROM or diskette into a drive and determine the
source drive letter; for example, D.
3. Type the following syntax from your C:\ drive to install the DOS
software to your hard disk drive:
mkdir xact
d:\install product_name destination_path
where product_name is any one of the products listed in Table D-1
and destination_path is your target drive and one of the two
possible installation directories listed in Table D-1.
Note: If you have an existing installation in the XACT directory and
you have enough space, Xilinx recommends that you install
XACTstep to a new directory. This procedure enables you to validate
the new installation before removing the old software.
4. Update your configuration file manually with the required
environment variables, referring to the “Setting Up Your
Environment” appendix for information.
5. Attach the required Xilinx key as described in the “Installing PC
Products” chapter, then continue with the next section,
“Authorizing Your Software from DOS,” in the current chapter, to
authorize your software.
Note: If the key is installed on the same port as an external CD-ROM
drive, attach the drive to the port and then the key to the drive.
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Authorizing Your Software from DOS
To authorize your software from DOS, you must execute the XKey
program from DOS. Use the following instructions to execute XKey.
1. Type the following command:
xkey -w↵
This command prompts you for the serial number and passwords.
2. Locate the serial number of the key on its case and enter the serial
number and passwords as shown in the following example:
C:>xkey -w
xkey [5.2.0] --

Xilinx Automatic CAE Tools

Copyright (c) 1995 Xilinx Inc.

All Rights Reserved.

Please enter the key serial number, a hexadecimal number
between 00000000 and FFFFFFFF, inclusive:
> C1234567
Enter password #1:
mjckafjjsgatvhc6qwd4
Enter password #2 (<RETURN> if none):
Password(s) accepted.
Update complete.
Done.

Note: XKey input can also be redirected from a file containing three
lines of information as follows:
Example of keyfile.dat file:
C1234567
sd579fgdi6f7fklkk75h28

●

The first line of the file should be the key serial numebr followed
by a carriage return.

●

The second line of the file should be the Password followed by a
carriage return.
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●

The third line of the file should be a carriage return (no text) if
there is no second password.

Example command:
C:>xkey -w < keyfile.dat

Running DOS Products in an MS-DOS Shell
After completing a product installation from Windows, you can still
run the XACTstep products from the DOS command line or from an
MS-DOS shell. This section explains how to run DOS products from
an MS-DOS shell in Windows.

Using QEMM or HIMEM for Memory Management
HIMEM users must use either the HIMEM.SYS that comes with
Windows 3.1 or the HIMEM.SYS that comes with DOS 6.0 or later.
Earlier versions of HIMEM.SYS limit the XACTstep 5.2 to 16 MB of
RAM.
QEMM users who use QEMM 6.x on PCs with more than 12 MB of
installed RAM should load QEMM with the "EMB=<KB installed>"
switch to use RAM.
Here is an example line in CONFIG.SYS (for 16 MB).
device=c:\qemm\qemm386.sys ram emb=16000

Running Windows 3.1 in 386 Enhanced Mode
To run your MS-DOS-based applications in a window, you must use
the 386 enhanced mode, which is the default mode.
Type win↵ at the MS-DOS prompt to invoke Windows.

Enabling the Virtual Memory Option in Windows 3.1
XACTstep Version 5.2 programs use Windows Virtual Memory if the
Virtual Memory option is enabled in Windows. You can either accept
the default settings or make selections.
To enable Virtual Memory and change the settings for Drive, Type,
and New Size, follow these steps.
1. Open the Main program group.
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2. Open the Control Panel from within the Main program group.
3. Select the 386 Enhanced icon.
4. In the 386 Enhanced pop-up window, press the Virtual
Memory button.
5. In the Virtual Memory pop-up window, select the Change button
and change the amount of virtual memory as suggested in the
“Recommended Memory and Swap Space” table in the “System
Requirements for Xilinx Software” section.

Opening an MS-DOS Prompt Window
1. In the Main program group, click on the MS-DOS Prompt icon.
2. If this action brings up the MS-DOS prompt in full-screen mode,
press Alt-Enter to switch to an MS-DOS Prompt window.
3. Select the button in the upper-left corner of the MS-DOS Prompt
window.
4. Select Settings in the pull-down menu.
A pop-up menu with a Tasking Options box opens.
If you want programs to run in the background in this MS-DOS
Prompt window, you must select Background in the Tasking
Options box.
If you do not select Background, any program that you run in the
MS-DOS window is suspended when you select any other window
(selecting a window puts it in the foreground).
Note: Programs run slower in the background than in the
foreground.

Running Graphical Programs in Full-Screen Mode
For graphical programs such as XDM or XDE, you must have the
MS-DOS prompt in full-screen mode.
Use Alt-Enter to switch between window and full-screen modes.
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Appendix E

Troubleshooting
This appendix describes possible errors or problems you might have
when installing on personal computers and workstations.

All Systems
This section addresses errors that might happen on all systems.

Insufficient Space for the Installation
The Setup program indicates if sufficient space is not available. If this
error occurs, follow these guidelines:
1. Use Custom Install.
2. Select only the product options that you need. Refer to the “Disk
Space Management” chapter.
3. Use the Analyze Disk Space and Set Path features in the “Disk
Space Management” chapter to control your installation at a
detailed level.

Data is Removed from the Installation Directory
Do not use the xinstall directory as your installation directory.
If you did use that directory by mistake, delete the directory and reinstall the software.

Mouse Is Incompatible
If your mouse is incompatible with the installation program, use the
keyboard commands listed in the following table to navigate and
select objects on the screen.
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Table E-1 List of Keyboard Commands
Key

Action

Tab

Traverse objects forward and highlight
them
Traverse objects backward
- Activate selection button or highlighted list item, including menu items
- Highlight list item
Scroll up or down inside selection
boxes, including menus
Select menu

Shift-Tab
Enter

Arrow keys
Alt-Character
Esc

-Unselect menu
-Exit Help window

PC Installations
This section addresses errors that might happen only on a PC.

You Have Trouble Invoking Install
Specify verbose mode (option -v) for more information on the
program start-up.

Setup Could Not Update Your AUTOEXEC.BAT File
If Setup could not update your configuration file for you, you must
update your AUTOEXEC.BAT file manually before running your
software. For information on how to update your configuration file,
refer to the “Setting Up the Xilinx Environment” appendix.

Out of Environment Space
There might be an “Out of Environment Space” error message
displayed when you boot your PC. In this case, increase your DOS
environment space by updating your CONFIG.SYS file as explained
in the “Setting Up the Xilinx Environment” appendix.
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Problems While Running XACT 5.2 Install from
Windows
In general, Xilinx recommends that you do not run install.exe from
the Program Manager File → Run menu. However, you can run it in
a Windows DOS shell. To do so, double-click on the MS-DOS Prompt
icon, then invoke the Install program. Also, due to limitations of the
MS-Windows emulation software used to create the Install program,
Xilinx recommends the following:
●

Do not use Alt-Tab to switch to Windows or another application.

●

Do not use Alt-Enter to switch to a window and back to a full
screen.

●

To exit the DOS shell, type exit↵ at the prompt.

●

Do not move an Install program window off the screen and then
back in view.

●

Do not click on a button that is not completely displayed.

Dates of the Installed Files Are Off an Hour
If you install software on a network drive, the dates of the files that
you installed might be an hour off due to the Daylight Saving Time
conversion.

Mouse Fails
The following covers possible solutions for failures you might have
with your mouse.
●

Your installation program does not have a built-in mouse driver.
Make sure the mouse driver that you are using is compatible with
MS-Windows. You do not need to have MS-Windows loaded on
your PC.

●

If you do not have an MS-Windows-compatible mouse, refer to
Table E-1 for information on how to enter commands from the
keyboard.

●

If the VLPCM environment variable is set, try resetting it by
typing the following:
set VLPCM↵
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After the installation, this variable is reset when you execute your
AUTOEXEC.BAT file.
●

If you are using a Logitech mouse, try loading the driver with the
Init parameter, for example:
c:\mouse\mouse init↵
You can reset the mouse driver after the installation is complete.

●

If you are using an old version of a mouse driver, try to upgrade it
to an MS-Windows-compatible version.

●

If you are using Version 4.55 of the Microsoft mouse driver, you
must upgrade it to a later version, because Version 4.55 is
incompatible with the installation program.

●

Version 5.1 of the Mouse Systems mouse driver, mscmouse.com, is
incompatible with the Xilinx installation program.
If you are using this mouse driver, you can get V7.10 of
mscmouse.com from the Xilinx Bulletin Board. Download the
MSYS7.ZIP file. For instructions on using the Xilinx Bulletin Board
(BBS), see The Programmable Logic Data Book.

Problems with the PC Keys
If your key is not working, it might be for one of the following
reasons:

E-4

●

Your key is not securely fastened. Check that the key is correctly
installed on the parallel port.

●

You are using a port that does not conform to the IBM parallel port
standard. To diagnose this problem, use the xkey -r command.
If the key is not found on your PC but can be found on another
PC, you are using a non-standard parallel port.

●

A printer or CD-ROM drive is attached to the same parallel port
as the key. When the printer power is turned off, the key may not
function. To correct the problem, either turn on the peripheral or
disconnect it from the parallel port. This problem is known to
occur on parallel ports using the WINBOND 83757F chip.

●

If you are using a Sentinel SuperPro key on the same port as your
Xilinx C key, ensure that your Xilinx key is attached after the
Sentinel key.
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●

If you run out of evaluation runs, contact Xilinx to get a password
that will authorize your software to run an unlimited number of
times.

Graphics Mode Is Not Set
As a default, the graphics mode is set to 4-color VGA. To change the
graphics mode, add the GRMODE environment variable to the
AUTOEXEC.BAT file, as explained in the “Setting Up the Xilinx
Environment” appendix.

Program Icons Were Not Created By Setup
If the Xilinx Setup program did not create a program group for your
Windows tools and program icons for each individual tool, use the
following instructions to create program groups and icons for
products you have installed.
1. Invoke Windows as follows:
win↵
2. Select File → New from the Program Manager.
The New Program Object dialog box is displayed, as shown in
Figure E-1.

Figure E-1 New Program Object Dialog Box
3. Select the Program Group option and click on the OK button.
The Program Group Properties dialog box is displayed, as shown
in Figure E-2.
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Figure E-2 Program Groups Properties Dialog Box
4. Type XACTstep 6.0 in the Description box.
5. Leave the Group File text box blank.
6. Click on the OK button.
A new program group box, labeled XACTstep 6.0, appears on your
screen.
Follow these instructions to create a program icon for the XACTstep
Version 6.0 software tools.
1. Select File → New from the Program Manager.
The New Program Object dialog box is displayed, as shown in
Figure E-3.

Figure E-3 New Program Object Dialog Box
2. Select the Program Item option and click on the OK button.
The Program Item Properties dialog box is displayed, as shown in
Figure E-4.
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Figure E-4 Program Item Properties Dialog Box
3. Type the name of the program you want in the Description box:
●

Design Manager

●

Floorplanner

●

Timing Analyzer

●

Hardware Debugger

●

PROM File Formatter

4. From Table E-2 below, select the path corresponding to the
program icon you want to create. The table assumes the software
is installed in c:\xact.
Table E-2 Program Paths
Program Description

Path

Working Directory

Design Manager

c:\xact\dsgnmgr.exe

drive:\xactuser

Floorplanner

c:\xact\fplan.exe

drive:\xactuser

Timing Analyzer

c:\xact\timingan.exe

drive:\xactuser

Hardware Debugger

c:\xact\hwdebugr.exe

drive:\xactuser

PROM File Formatter

c:\xact\promfmtr.exe

drive:\xactuser

5. Type the selected path in the Command Line text box.
6. Select the following working directory:
c:\xactuser
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Note: The working directory can be any directory you want, but the
XACTUSER variable must point to it in your AUTOEXEC.BAT file.
7. Leave the Shortcut Key text box blank.
Figure E-5 shows the filled dialog box used to create the Design
Manager icon.

Figure E-5 Creating the Design Manager Icon
8. Click on the OK button.
A new program item, with the program name you specified,
appears within the XACTstep Version 6.0 program group box as
illustrated in Figure E-6.

Figure E-6 Design Manager Icon

Workstation Installations
This section addresses errors that might happen only on
workstations.

Starting Install Generates Warning Messages on
HP-PA Systems.
When you start the installation program on an HP-PA system, ignore
the warning messages that are initially displayed.
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Incompatibility Between HP-PA and Sun
Workstations
You cannot run the Install program on an HP-PA by setting the
DISPLAY variable to a Sun workstation that is running
OpenWindows because of an incompatibility between X11R5 used by
the HP-PA machine and the Sun OpenWindows XServer. This
incompatibility causes the Sun Window Manager and the XServer to
crash. Normally, any processes running in the windows of that
display terminate.

Server Start-up Problems
Check the license manager activity by using the Xlmlog program to
report server startup messages. Start this program before starting the
license server. To use this program, enter the following:
xlmlog↵

Xlmasu Failed
If Xlmasu fails, the following messages are displayed:
xlmasu@zeppo: Xilinx License Manager Autostartup Version #V#
xlmasu@zeppo: License file: /home/venus/xact/license/
license.dat
xlmasu@zeppo: License manager servers will be started on
zeppo
xlmasu@zeppo: Server initialization waiting period started
xlmasu@zeppo: License manager servers could not be started on
zeppo
xlmasu@zeppo: Confirming the status of the servers
xlmasu@zeppo: License manager servers could not be started on
zeppo
xlmasu@zeppo: terminated abnormally

Zeppo is the name of the license server machine, and
/home/venus/xact is the installation directory.
The cause of this error can be any of the following:
●

You cannot write into the $XACT/license directory.
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●

You cannot use “rsh” (or “/com/crp” for Apollo, or “remsh” for
Hppa) commands to the license server machine.

●

The Xlmasu program is found in your path somewhere other than
in $XACT/bin/sparc. The Xilinx license manager programs look
for the license file by assuming that they are in $XACT/bin/
cpu_type and looking for ../../license/license.dat.

The $XACT/license/README file has more information about the
new licensing implementation.
The licensed programs expect that the license file is $XACT/license/
license.dat and that the programs are in $XACT/bin/cpu_type.
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